
 

 

 

 

 

 

 

 

 

 

Objectives 
 

This unit will provide an introduction to the MS-Windows XP client operating system. The 
emphasis is on the minimum knowledge required to work productively on your Personal 
Computer.  

A good basic knowledge of the way in which the operating system works is essential, be-
cause no matter what application you will be using, you will be confronted with the same 
common interface elements. 

This unit will introduce the following learning objectives: 

• What does the operating system do? 

• How to use the mouse and keyboard. 

• The appearance of the basic desktop and the names of its elements. 

• How to start and close an application or a document. 

• How to control the appearance of document and application windows. 

• How information is stored on your computer and how you can find it. 

• How to manage multiple applications at the same time and how to transfer informa-
tion between them using the clipboard. 

• Introduction of some useful Windows accessory applications. 
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Introduction to MS-Windows XP 

What Is the Function of the Operating System? 
Microsoft Windows is the operating system of your personal computer. It is usually referred 
to as MS-Windows, or even “Windows”. Without an operating system, you would not be able 
to use your personal computer. It performs the following functions.  

• It is the interface between your hardware and your application software: e.g. it di-
rects output for the printer, checks the various storage devices, interfaces with the 
monitor or sound card etc. 

• It manages the various applications which you are running: e.g. it allocates the cen-
tral memory and central processing time between the active applications, ensures the 
integrity of data which is used by more than one application or user at a time, pre-
vents “misbehaving” programs from damaging your other applications, enables the 
transfer and linking of data between applications etc. 

• It manages the storage of data (and program) files on disk. It keeps track of where 
and how your data and programs are stored on your floppy or hard disk. 

• It is responsible for the common look, feel and operation of the shared functions of 
all applications e.g. keyboard and mouse input, functionality of the windows, on-line 
help, opening and closing documents, printing and font handling. The “look-and-feel” 
of the operating system is also referred to as the user interface. 

• It comes with a number of frequently-used tools built-in such as a calculator, a note-
pad, screen saver, multimedia player, graphics editor, system utilities and even some 
games.  

Every few years, Microsoft – the company that develops and markets MS-Windows – cre-
ates an updated, more powerful version of Windows. To keep track of the different versions, 
each has its own version name. Although a very early version “Windows 1.0” was released 
in the 1980s, the first widely used version was Windows 3.11. This was followed by the 
hugely popular Windows XP and Windows 98, and the less widely spread Windows 
2000/ME. The latest version is Windows XP. It is a very powerful operating system support-

ing many advanced features such as networking, security, 
multimedia and powerful accessories.  

In this guide, we will only introduce those few features that you need to get started. We have 
tried to be as generic as possible so that, even if you are using an older version of Windows, 
you should still be able to find your way around. It is possible, and indeed fun, to customize 
(or change) almost every single element of the Windows interface. So if you are using a 
computer that is being used by other people, chances are that some user interface elements 
have been changed.  
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A Graphical User Interface 
Windows XP is an operating system with a graphical user interface (“GUI”). This means 
that it represents commands and options graphically on the screen using icons (small pic-
tures on which you can click) or menus (lists of commands from which you can select).  

The Desktop Metaphor 
Windows XP uses the metaphor of a desktop from which all your information processing 
tools and information is accessible. On your monitor, you will see a stylised image of your 
electronic desk: this might include a clock, a calendar, an address book, a calculator, incom-
ing mail but also a spreadsheet and a word processor. 

 

Windows 
Each of the tasks or jobs that you are busy with has its own window and you can freely 
switch between the various tasks or windows as you wish. Windows are typically partially on 
top of each other, so you can have several windows visible on your desktop at once. (Hence 
the name of the operating system: Windows!) When you want to devote all your attention to 
one specific task, you may wish to expand the size of its window so to take up the entire 
screen (called maximizing the window), thus obscuring everything else on the desktop that is 
now underneath it. 

The “Calculator  
Window” 

Icon 

The “Calendar 
Window” 

Icon 

Menu 

Cursor 
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Essential Input Skills  
You will need to master the following skills in order to operate Windows XP. 

Using Your Mouse 
One of the most important input devices is the pointing device that 
comes with your computer. It can be a mouse, a trackball, a touch 
pad, or a similar device. We will assume that you use a mouse as 
your pointing device; most other pointing devices operate on similar 
principles.  Some mice have three buttons and/or a wheel; test the 
middle button to see what it does!  

The following mouse actions are critical GUI survival skills. 

Clicking a (screen-) object: move the physical mouse in such a way that the 
mouse cursor on your screen (usually an arrow, hour-glass or I-shape) moves to 
the object to be selected or activated. Press the left-button down and release it 
again without moving the mouse. 

Right-clicking an object: as above but use the right-side but-
ton instead. This typically displays a menu with special and ob-
ject-specific commands. On the left is an example of a “right-
click menu” for the “table_mountain.JPG” icon. 

Double-clicking an object: the same as (left-)clicking an object 
but you press and release the left button twice in very quick 
succession. New users find it sometimes difficult to perform this 
action without moving the mouse at all. It is also important to be 
very quick since you have about two-tenths of a second to per-
form this press-release-press-release action. Playing arcade games is a good way to prac-

tice! 

Dragging an object (such as a graphic in a docu-
ment) usually with the intention to move or copy the 
object: position the mouse cursor on top of the ob-
ject, press the button down but do not release it. In-
stead move the mouse so that the cursor (and the 
object underneath it) moves across the screen until 
you arrive at the desired location where you can re-
lease the button and accordingly “drop” the object. 

(Note: A window can only be dragged by dragging its title bar) 

Hovering your mouse above selected icons or menu options may display 
tooltips or smart tags with a brief description of what the icons does or related 
information. E.g. hovering your cursor above the Print icon will display the name 
of the default printer, hovering above the time on the task bar will display the current date. 

Right 
button 

Left 
button 
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Using the Keyboard 
The keyboard is used mainly for typing text. Because it is often not convenient to switch from 
keyboard to mouse, it also allows you to select commands. The following special keys are 
important. 

 

Function keys are located along the top of your keyboard and labelled F1, F2 … F12. 

Cursor or arrow keys move the text cursor that controls where you enter or edit the text (or 
objects) in your document. The text cursor is usually a flashing vertical bar.  

Combination keys require the holding down of two (or more) keys simultaneously. They 
typically involve the use of one of the following three keys: Shift, Ctrl and/or Alt. When re-
quired to type e.g. <Alt>-B you would do the following: first press and hold down the Alt key, 
then press and release the B and (more or less simultaneously) release the Alt key again. It 
is important not to hold down the keys too long (i.e. less than about a tenth of a second) and 
also to first press (and hold) the respective keys. Some commands require you to press 
three keys simultaneously as in <Ctrl>-<Alt>-C. This may seem impossible now but it will 
make sense after some practice.  

Toggle keys allow you to choose a permanent shift state. Their state is indicated by means 
of a little diode light on your keyboard. The <Caps Lock> key, when press once, will allow 
you to type text in all capitals until you press it again when you revert to lower-case letters 
again. The <Num Lock> key does a similar thing except that it applies to the numeric key-
pad only: it allows you to choose between using the cursor (arrow) keys (usually moving the 
text cursor key) and digits (for numeric data entry). The function of the <Scroll Lock>-key 
depends on the application. 

Editing keys are keys with a fairly generic meaning: they perform similar actions in most 
applications though there may be small differences depending on the applications.  <Back 
Space> typically erases the text character (or any other object) to the left of the text cursor, 
<Del> erases characters to the right of the text cursor, <Tab> moves the position of your text 
cursor to a next field. 

Function keys 

Cursor keys 

Enter key 

Ctrl Alt 

Toggle key 
indicators 
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Elements of the Windows XP Desktop Screen 
The screen you see after loading Windows is the desktop: your electronic work space. This 
workspace may be customised to a large extend to reflect your work habits and preferences, 
although generally not by network users. The following elements are found on a “standard” 
installation of Windows XP. 

 

 

The Start Button  
 The start Button, usually found in the bottom left corner of the screen, 
provides you with the start Menu from which you can access every ap-

plication as well as the documents you worked on recently. It also allows you to change the 
set-up of your system, provides you with help on how to operate Windows XP and allows 
you to shut down your system in an orderly manner when you have finished working. 

The Task Bar 

Normally, the task bar is always visible at the bottom of the screen. It lists all the tasks that 
are currently active by means of a small icon and short description.  

On the right of the task bar is the notification area. It may display small icons usually related 
to background tasks that are continuously managed by the operating system i.e. tasks that 
are taking place while you are working on something else. Examples are the printing of a 
document, the playing of music on your CD-ROM drive, charging of your notebook battery, 

Application 
Window 

Desktop 
Icon 

Desktop 
Background 

Taskbar 
Notification 
Area 

start 
button 
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the receiving of a file via the network, etc. Right clicking on these items allows you quick ac-
cess to information about these tasks. You are also often able to affect their operation, e.g. 
change the volume of your speaker or stop the printing of your document. 

At the extreme right, you will also usually find a clock representing current system time. 
Hovering your mouse above the time will display the current date. 

Desktop Icons 
Various desktop icons will be positioned on the desktop in an orderly or random manner. 
They are a quick, alternative way to access frequent tasks: just double-click. Some of these 
icons represent commonly used applications while others take you directly to documents. 
Icons of programs that think highly of themselves will remain floating on top of application 
windows (they also only need a single click.) Some important desktop icons are: 

My Computer: explore your personal computer, the attached hardware and 
change its configuration. 

Network Neighbourhood: explore the resources available on your computer network. 

Recycle Bin: the electronic version of a wastebasket where all files are sent to 
when they are deleted. You may be able to recover these from the recycle bin by 
clicking on the bin. 

Application Windows 
As soon as you have “launched” a task, it will have its own 
window. Many windows may be visible on the desktop, often 
partially overlapping each other. The task that is currently 
active i.e. the one that you are busy with will have a blue title 
bar (default set-up). A task that is not active but seeks your 
urgent attention (e.g. printer fault, schedule reminder) may 
have a flashing title bar although a really urgent task that re-
quires immediate action will probably take over and super-
impose a message window on top of the desktop.   

Desktop Background 
You can choose between a variety of backdrops or images to customise the way the back-
ground of your desktop looks. This allows you to fill up the empty space not occupied by ap-
plication windows or icons with something more attractive, distracting or any other expres-
sion of your personal temperament or personality. 

Screen Saver 
If no keyboard or mouse activity occurs for a while, the entire desktop may change to an 
animated or artistic image. 
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Where to Find More Information 
These notes will provide you only with the basics of Windows XP. In your local bookshop, 
you are likely to find many books introducing you to Windows XP. Warning! Do not buy any 
programmer or technical guide to Windows since they deal with much more advanced fea-
tures. If you have a computer at home which has Windows XP loaded, you have a copy of 
the Microsoft Users Manual that comes with your software or computer. But there are three 
other on-line resources you should use immediately. 

The On-line Tour to Windows XP 
Windows XP comes with an introductory tour demonstrating its basic functionality and op-
tions, as well as more advanced topics. To see the tour, follow the following steps.  

Step 1: Click the start button on the task bar.  This will display the 
start menu. 
Step 2: Click the Run… 
option of the start menu.  
This will open the Run 
window. 

Step 3: In the Run Win-
dow, type the following 
text in the “Open:” text box: 
“C:\WINDOWS\System32\tourstart.exe”.  Note: NETWORK users 
may need to enter a different path (text). 

Step 4: Click on the “OK” button. 

An alternative way of launching the Windows XP Tour is by going to the Programs option of 
the start menu, selecting the Accessories folder and choosing Tour Windows XP. 

 

Getting Help on Specific Issues 
If you have a specific problem or query, you may find a direct answer in the Windows help.  

Click the start button on the task bar (see step 1 above). This will display the start menu. 

Click the Help and Support option on the start menu. This will open the Help and Support 
Center window. 

Step 1 

Step 2 

Step 3 

Step 4 
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If you do not know the exact word which describes your problem (or if you cannot find a rele-
vant entry in the index as per below) you should enter some of the words describing your 
problem in the search box. This allows you to search the entire help file for specific words or 
phrases. Although it is a slightly slower method, it is much more general. 

 

If you know the exact technical word for your 
problem, you should click the Index tab of the 
help window. This displays an alphabetical index 
of all keywords on which Windows provides 
help. Type (the first few of letters of) the word 
that you are looking for and the list of keywords 
will automatically scroll down to the relevant en-
try.  You may wish to try a synonym or related 
word if the word that you are looking for is not 
listed. 

Windows help will often offer to demonstrate 
how to perform a certain action by indicating a 
“Click here to …” button.  At the bottom of a spe-
cific help screen, there is usually also the option 
of clicking through to Related Topics.  

To exit help, click the closing icon in the top right corner of the window. 

Search the web 
The web is full with useful information and tutorials on how to use Windows and Office. Do a 
simple search – or visit www.microsoft.com – to have almost any query answered. 

Step 1 
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Starting and Quitting a Program 
There are a number of different ways to start a program or application.  

Various Ways of Starting a Program 
1. If the program has an icon on the desktop, you can load it by double-clicking its 

icon. 

2. If you want to edit an existing document that was created by the program or applica-
tion, Windows XP remembers which program can edit the document and will auto-
matically load the program along with the document. Load the document from Win-
dows Explorer, the Document-option on the start menu (if it’s a recent document) or 
its icon on the desktop (if you have created one.) 

3. Use the Run-command from the start menu. This requires you to remember its loca-
tion on your hard disk and some familiarity with the way Windows locates information 
on the disk. Refer to p.8 “How to run the Windows Tour” for an example. 

4. Use the Programs-option from the start menu. 

Since this last option can always be used, it will be demonstrated below. 

How To Start a Program from the Start Menu 

Click the start button (step 1a) and select the Programs option (step 1b).  
Note: to select an option that has sub-options (indicated by a solid sideways triangle 4), 
you can just move the mouse cursor above the option (without clicking): the sub-menu will 

Step 1b 

Step 2a 

Step 2b 

Step 1a 
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be displayed automatically. Move your mouse cursor sideways across to the sub-menu. A 
chevron at the bottom of a menu indicates that more (but infre-
quently used) menu items are available – these will be displayed 
by clicking on the chevron or by waiting for a short while. 

Select the folder that contains the program (step 2a), and click 
the desired program (step 2b). The program will be loaded, open 
its own application window and a button for the application will 
appear on the taskbar. 

To Quit a Program 
There are a number of different ways to quit (also known as exit or close) an application. 

1. Click the Close button in the up-
per-right corner of the window. 

2. Click on the program icon (top 
right corner of the window) and se-
lect close from the window. 

3. Press <Alt>-<F4> on the keyboard 
(known as the keyboard shortcut). 

4. Select the Exit option under the 
File-command.  

o Using the mouse: click on 
File, and move the cursor 
down to and click Exit.  

o Using the keyboard: press 
<Alt>-F to select the File 
menu and then press X. 

Before closing an application, make sure that you have saved all the information. Many pro-
grams, including all Office programs, will remind you if you have made changes since your 
last “save” and you want to exit the application. 

A Note on Using Menus 
As noted above, apart from clicking a desired menu option, you can also use the keyboard. 
Press the <Alt> -key in combination with the underlined letter of the menu option e.g. F for 
the File menu, E for the Edit menu.Note: it is not always the first letter of the menu option. 

In the default setting for Office XP, only the most frequently used options on each menu are 
displayed. Waiting a short while or clicking the  button will display the less frequently used 
menu options. (Advanced users may change this default in Office XP using the Tools • 
Customize • Options • Always show full menus setting.) 

Additional 
menu items 

Close 
Button 

Keyboard 
shortcut 

File 
menu 
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Working with Windows 
All applications, tasks, documents and even some menus and system messages appear in 
separate windows. Most windows share a number of common features that control their ap-
pearance and location on your desktop. It is important that you recognize these features be-
cause you will be working a lot with various windows.  

 

 

The Window Title Bar 
The top bar of a window displays the title or name of the window. If it is an application, the 
window title is the name of the document that you are 
editing followed by the name of the application. The bar 
will be darker blue (or another colour if you changed the 
Windows desktop settings), if the window is currently 
active i.e. processing your keyboard inputs.  

If it is an application window, the program icon will ap-
pear on the left of the title bar. Clicking on this icon will 
present a menu that allows you to exit the application or 
customise the window size and location. Alternatively, 
you can click one of the buttons described below. 

Using the Buttons on Title Bar 
On the right of the title bar, you may find some of the following buttons: 

The Help or Question Mark button; found on many dialog windows. Click on this but-
ton, followed by a click on any window item, to see more information about the item. 

The Minimise button. Click on this button to remove the window from the desktop. 
However, the task remains in memory and can be made active again by clicking on 
its taskbar button. 

The Maximise button. This will expand the window to fill up the entire desktop. All 
other open windows will be hidden underneath the maximised window. The Maxi-
mise button will disappear and be replaced by the Restore Down button. 

The Restore Down button. This will shrink a maximised window back to its original 
size. 

Program 
Icon 

Document 
name 

Click on icon for 
window menu 

Minimize, Maximize 
and Close Window 

Application 
name 
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The Close button. This will close the window completely. If it was an application or 
document window, you will exit the application or document. If the window had a 
taskbar button, it will disappear. The task has been terminated and is removed from 

memory. 

Moving a Window 
To move a window to a different location of the desktop, drag the title bar to the desired loca-
tion. Move the mouse cursor anywhere on the middle section of title bar, press and hold 
down the left button, move the cursor (along with the entire window) to the desired location, 
and finally release the right button. You can obviously not move a maximised window. 

Changing the Size of a Window 
Change the size of a window by dragging any one of its borders until you are satisfied with 
its size. The mouse cursor changes to a double-arrow when it crosses a window border to 

indicate this option. You can change the width and 
height simultaneously by dragging one of the corners of 
the window. 

Some windows have a fixed size; you cannot change 
their size. And you can (obviously) also not change the 
size of maximised windows. 

It is also possible to change the window size by clicking 
on the program icon (top left corner) 

Scroll Bars 
Many programs allow you to edit documents that do 
not fit in the window. You should visualise your 
document as being “behind” your monitor and the 
window just shows you one small portion of the en-
tire document. Horizontal and vertical scroll bars will 
show the position of the window relative to the en-
tire document.  The size of the scroll block repre-
sents the relative size of the portion of the docu-
ment which is visible in relation to the entire docu-
ment. By dragging the block you can move the win-
dow quickly over the document. Clicking on an 
“empty” part of the scroll bar will move the window 
one screen in that relative direction. Clicking on the 

arrow button of the scroll bar will move the window a little in the respective direction. 

 

 

Vertical re-size cursor: 
 
Horizontal re-size cursor 
 
Diagonal re-size cursor 
 
Diagonal re-size cursor 
 
Move window cursor 

Horizontal 
Scroll Bar 

Drag scroll block 
to move the win-
dow up or down 

Click to move 
one line up 

Click arrow to 
move a whole 
screen down 

Vertical 
Scroll Bar 
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How Information Is Stored on Your Computer 
The information that is stored on your computer consists of two types: documents and pro-
grams. They are both stored in the same way and this storage is physically organised in a 
hierarchical manner. 

Files 
Documents (and programs!) are stored as one (or more) files. Files have a name 
(given by you on creation), size (measured in bytes or kilobytes) and various techni-
cal attributes such as the date and time when last modified, which program created 
it, whether the file has been backed up (Archived), whether the data can be modified 
(Read-Only or not) etc.  

A simple document such as a letter or spreadsheet will be stored in one single file. 
Complex documents such as multiple chapter books or large databases can be split 
up in many different files. Programs are also stored as files, though Windows treats 
them as a special type of file. 

The most important identifying element of a file is its name. This name can be any one-line 
textual description consisting of letters, digits, spaces, and some special symbols. Windows 
will also assign a default file “extension” which consists of three 
additional letters to identify the type of file e.g. the originating appli-
cation for document files or the technical type for program files. 
Programs which are were not especially designed for Windows XP 
may not be able to process a long file name and Windows XP will create an eight-letter ab-
breviation for their benefit.  You may have many files with the same name as long as they 
are stored in different folders. 

Folders 
If you create many files, you will find that you need to organise your files. 
Similar files or documents are grouped in folders.  Although a folder can 
contain as many files as you wish, it makes sense to limit your folders to a 
reasonable and easily searchable number of files. You can give a folder 
any name you like and group your files into folders according to date, pur-
pose, project, application or any other way you consider most appropriate.   

It is important to note that folders can contain (sub-)folders which can again 
contain (sub-sub-)folders etc.  This structure of folders within folders within 
folders can be visualised as a tree. The primary folders are said to be lo-

cated at the root of this tree.  Folders are also identified by a name which is similar to the 
names given to files.  You can also create two or more folders with the same name as long 
as their parent folders (i.e. the folders they are a sub-folder of) are not the same. The full list 
of folders all the way “down” to the root is called the path. 
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Drives 
Folders and their files are stored on disk drives. Drives are identified through a capital letter 
followed by a colon e.g. C: or F: .  Drives may be one of the following. 

• Floppy or stiffy diskettes: these have a very limited stor-
age capacity and very slow but are portable or remov-
able media i.e. you can take them with you. This is nor-
mally the A: drive. If you have two diskette drives, the 
second drive will be the B: drive. 

• Hard drives inside your computer: these are much faster 
and have many times the capacity of a diskette but are 
(usually) not removable. The first hard drive is identified 
as your C: drive and if you have more than one (or if the 

drive has been split or partitioned into large parts for technical reasons) the subsequent 
drives will be named D: , E: , etc. 

• You may have other types of drives, e.g. an optical drive such as a CD-ROM, WORM or 
DVD.  These will be normally be identified by the next available letter in the alphabet. 

• If you are linked and logged in to a network and you have access or storage space on 
the network server, the drive(s) of the server will be mapped as additional available 
drives.  Normally there will be quite a few drives, usually starting from F: and then down 
the alphabet. 

Paths 
Although most of your work with files in Windows applications will be done using a graphical 
interface, every now and then you will be required to deal with a full file name, including its 
path. In essence, this is an unambiguous textual description of where the file is located on 
your system. 

A typical path name includes the drive, the list of all the folders from the root down to where 
the file is located and the file name. An example of a path would be: 

C:\My Documents\My Pictures\Family\2002\Jim is having fun.JPG 

This references the file with the name “Jim is having fun”, of the type “JPG” (a typical graph-
ics file format used for digital photographs). The file is located in the folder “2002”, which can 
be found inside the folder “Family”, which is inside the folder “My Pictures”, in its turn inside 
“My Documents” which resides on the C: hard drive. 

Sometimes, a relative path is used as in: 

 ..\Family\2001\Art.doc 

This would indicate file “Art”, a word document, in the folder “2001” inside the folder “Family”. 
The “Family” folder can be found in the parent folder of the current folder. 
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Opening and Saving a Document 
Just like there are different ways of starting a program, there are several ways in which to 
open a document,. 

• Double-click a document icon on the Desktop, within the Windows Explorer, or from 
within My Computer. 

• Use the Search command on the start menu to locate the document and double-click 
its icon. 

• Load the application which created or edited the document and use the File Open 
command. Some applications list the most recently edited documents at the bottom 
of the File sub-menu so you can select them directly. 

• Use the Documents sub-menu from the start button. This only works for documents 
that have been edited relatively recently by applications.  

To Open a Recently Used Docu-
ment from the Start Button 
 

Step 1: Click the start button and point to the 
Documents sub-menu (or type the letter D). 

 

Step 2: From the Documents sub-menu, select 
the document you want to open by clicking it. 

 

To Open a Document from Within an Application 
Select the File menu by clicking on the File command or pressing 
<Alt>-F.  

Select the Open… option which will take you to the File window 
which allows you to enter or search for any document file. 

Some applications will list the most recently used documents at the 
bottom of the File menu so that you can open these documents 
directly without having to go through the File window. 

A quick alternative to the menu is by clicking the Open 
Folder icon on the standard toolbar or using the <Ctrl>-
<O> keyboard shortcut. 

Step 1 

Step 2 

Step 1 

Step 2 
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Saving a New Document 
One of the most important skills is the saving of your document. Regardless of the applica-
tion that you are using, the way in which a document can be saved is the same. 

If your application 
has the standard 
toolbar, you can sim-
ply click on the disk-
ette icon.   

The alternative way to save is to select the Save option from 
the File menu or the <Ctrl>-<S> shortcut key.  

This will open the following dialogue window: 

 

By double-clicking on the appropriate folder and entering a file name, you will be able to 
save your document for future use. This window will not pop up on subsequent saves, since 
your application will use the same filename and folder to store your document. If you wish to 
save a changed or edited document under a different name or in a different location (folder), 
you can use the Save As… option of the File menu. 

File names can generally include any letters, numbers and spaces. Avoid special characters 
and punctuation symbols, because many carry special meanings to the operating systems 
and are thus not acceptable or will result in unpredictable behaviour. The following charac-
ters should certainly not be used as part of a file name:  \ / : * ? " < > |. 

 

Create a 
new folder 

Enter the file name here 

Double-click on 
any folder to store 
your file there 

Click to select 
another drive 

When finished, 
click here to 
save the file 

Go to the  
parent folder 
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Managing Many Programs Simultaneously 
Windows XP allows you to use many different programs (also called applications) simulta-
neously. The number of programs you can open at one time depends on the complexity of 
each program and the amount of memory your computer has. Each program can conceiva-
bly launch a number of separate (sub-)tasks and open any number of different windows. E.g. 
a word processor could edit a number of documents simultaneously (each with their own 
window) and also launch a number of background printing jobs. Depending on your prefer-
ence settings, different (document) windows belonging to the same program may or may not 
represented separately on the task bar.  

When the number of applications exceeds the available button space on the task bar, a tiny 
caret scrollbar appears on the left, allowing you to scroll between different taskbar lines. 

 

If you often work with many applications simultaneously, you may want to increase the 
height of your taskbar by dragging its upper border up. 

 

Foreground and Background Tasks 
At any time only one program is active i.e. in the foreground: it is the program that processes 
all keyboard input. It can be recognised by the coloured title bar (dark blue in the default set-
up). Another indication of the active task is its button on the taskbar, which will appear as a 
“depressed” (darker blue) button. All other programs are said to be in the background; 
though they may still be busy processing data e.g. printing, downloading from the internet or 
calculating. The background applications may still have windows “open” on the desktop, 
though the window of the active application will always be “on top” of all other windows.  

Minimising a Program 
By clicking on the minimise button a program becomes a background pro-
gram. Its window will disappear from the desktop. 

Minimising or Restoring All Programs 
A quick way to minimise all programs (with open windows) is by right-
clicking on any blank space on the taskbar and selecting the 
Show the Desktop option or clicking the Show Desktop icon 
on the task bar. It clears your desktop. You can also restore 
all minimised programs back to their original windows the same way. 

Minimize 
Button 
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To Switch between Programs 
If you have several programs loaded, you can easily switch to the application you wish by 
clicking on the taskbar button of the program you wish to make active. This will make the 
previous application a background application.  

 

Another way of switching to another task 
that has a (part of its) window visible on 
the desktop is by clicking anywhere on its 
window. The window of the previous ap-
plication will remain on the desktop but 
may now be obscured partially by the 
window of the foreground application i.e. it 
now moves “underneath” the active appli-
cation. Many windows may be overlaying 
each other, the most recently used ones 
on top of previous ones i.e. in historical 
sequence. 

The keyboard equivalent for switching to 
a different task is <Alt>-<Tab> 

 

 

 

 

 

By loading the Windows Task Manager, you 
can get a much more detailed and technical 
overview of which applications are running and 
how much of your computer resources they 
are using. Use the <Ctrl>-<Alt>-<Del> key 
combination to access the task manager. This 
is a useful key combination to remember, 
since it also allows you to end a misbehaving 
application which appears to have locked up 
(disabled) your computer. 
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Introducing Some Windows Accessories 
Windows XP includes a number of interesting applications. These accessories are available 
by clicking the start button, select Programs and then select the Accessories group (which 
should appear near the top of the program sub-menu).  This will list various utility programs 
that are available to you; the exact number depends on your Windows installation and the 
configuration of your computer. 

Calculator 
If you want to do some quick calculations without 
wanting to load an entire spreadsheet applica-
tion, consider using Windows XP’s calculator. 

Its appearance (“interface”) is very intuitive. You 
can enter numbers and mathematical operators 
using the numeric keypad or use the mouse to 
click the buttons on the calculator.  

The calculator is more powerful than it may 
seem at first sight. If you want to do more ad-
vanced calculations, such as statistical or scien-
tific calculations, you can switch to the scientific 
calculator by clicking the View menu option. The 
scientific calculator also allows you to perform conversions between different number sys-
tems e.g. decimal to binary or hexadecimal. 

Notepad 
Do you quickly need to take some short notes or edit a small text file? Notepad will do the 
job quickly using only a tiny amount of system resources. It is a tiny text editor. You cannot 
do any text formatting or work with fancy fonts. 

WordPad 
If you want to do some slightly fancier word proc-
essing, you could do worse than give WordPad a 
look. Although it is not as powerful as a dedicated 
word processor and it doesn’t give you access to 
advanced lay-out and graphics, it is perfectly 
suited for simple tasks such as correspondence 
and assignments. Because it is relatively uncom-
plicated, it has a short “learning curve” (the time it 
takes to learn to use it) and uses not many system 
resources. Best of all: it comes free with your op-
erating system. It is also a good introduction to 
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more powerful Windows word processors. 

Paint 
Do you feel like a budding artist?  Try your hand at 
the Paint program that comes free with Windows 
XP. It is a simple drawing, colouring and painting 
application with a relatively intuitive interface.  It is 
great fun to play with and you can use its drawings 
in any other application you would like to – or even 
use them as your desktop background.   

(When my young children come and visit me at my 
office, their first question is: “Daddy, can we play 
Windows?” Translated in adult-speak, this means 
drawing something in Paint and printing it out on 
the laser printer to show mommy!) 

 

 

 

Windows Media Player 
The Windows Media Player will 
play a very wide variety of mul-
timedia files, including sound 
and music (MP3, Wave, MIDI 
etc.) as well as movies (e.g. 
MPEG). It comes with a large 
variety of dazzling visualizations 
and powerful CD capabilities. 

 

And Many Others … 
Depending on the configuration of your system, you may have many other exciting Accesso-
ries available to you, such as the Photo Editor and some exciting games. Go forth and ex-
plore! 
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Copy, Move or Delete Information 
Windows provides you with a clipboard that acts as a temporary holding place for informa-
tion. It is ideal to move or copy information from one application to another although it can 
also be used to move information within one single document.  

Copying or Moving Text To the Clipboard 
Select the text you wish to copy or move by highlighting the portion of the text you are inter-
ested in. The easiest way to do this is by dragging the mouse cursor from the beginning to 
the end of the text you wish to select.  This may take some practice to get right. Note that 
many applications will also allow you to select text using the cursor keys in combination with 
the <Shift>, <Ctrl> or <Alt> key. 

Click on the Cut (or scissors) button to move the text (i.e. cut or remove 
from the original document) or the Copy button to copy the selected text 
to the clip board. The text is now placed on the clipboard. 
Instead of clicking on the icons, you may use the shortcut keys to perform the same action: 
<Ctrl>-X to move or <Ctrl>-C to copy the selected text.  

Yet another alternative is to use the Cut and Copy options from the Edit menu. 

Inserting Text FROM the Clipboard 
1. Move your cursor to the location in the destination document where you want to in-

sert the text. 

2. Click on the Paste icon. The text will now be inserted in the document. 
Alternatively, use the shortcut key <Ctrl>-V or the Paste option from 
the Edit menu instead of clicking the Paste icon. 

If you wish to insert the same text in other locations or documents, you can repeat steps 1 
and 2 as many times as you wish, until you place some other text on the clipboard. 

Copying Other Objects 
The clipboard can also be used for non-textual information. You can copy or move pictures, 
drawings, tables, clip-art and other objects. Follow exactly the same steps as above but to 
select a single object, it is often sufficient to just click on the particular object once to high-
light the object. In fact, you can select text and objects located in the text in one pass. An-
other method of copying objects, say a picture on a web page, is by right-clicking the object 
concerned and selecting the Copy menu option. 

If you have copied an object from one Windows application to another, you can edit it at a 
later stage by double-clicking it. Windows “remembers” which application originated the ob-
ject and will load that application automatically. This object is said to be “embedded” in the 
(destination) document. 
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Old non-Windows compliant applications may not know how to handle a complex object from 
the clipboard and may change its format slightly or even turn it into complete gibberish. 

Deleting Text or Objects 
You can delete text or objects from a document by highlighting them and pressing the <Del> 
key. 

If you move something to the clipboard, and then move (or copy) something else to the clip-
board, the first item will be lost. This provides an alternative way of deleting information, us-
ing the Cut icon. 

Moving Information by Dragging 
If you wish to move text or object within a document or to another application, you can use 
the dragging alternative. Highlight the information, place the mouse cursor on top of the 
highlighted area and drag the selected information to its new position. 

The Extended Office Clipboard 
If you are working within MS-Office applica-
tions, you can place several items at once on the clip-
board.  

The Office Clipboard is usually available in a separate 
task pane, or you can access 
it from the Edit menu (or by 
clicking on the Office Clip-
board Icon on the task bar). 
You can then selectively 
paste certain or all objects 
into your target document.  

Where a large number of ob-
jects needs to be copied or 
transferred, this method 
saves lots of switching between applications. 
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Sharing Information between Applications 
The “copy-and-paste” process of embedding information from one application into another is 
not always ideal. If you update or modify the object in the original application, its copy (or 
copies) in other documents will not be updated. However, it is possible to create a dynamic 
link from the original object to all its copies (assuming they reside on the same computer or 
network). There are two different ways of doing this. 

Using the Clipboard 
If both the source (or original) and target (or destination) 
applications are loaded, it is still possible to use the clip-
board to create a link.  

Copy the object to the clipboard from the source using 
the Copy icon, the <Ctrl>-C shortcut key or the Copy 
option on the Edit menu. 

Insert the object from the clipboard into the target using 
the Paste Special … option from the Edit menu.  The 
Paste Special option may display a further window 
which may require you to tick a box if you wish to main-
tain a link. 

There is no shortcut key or icon equivalent for Paste Special. Programs that do not support 
object linking will not list Paste Special as an option under the Edit menu. 



© Jean-Paul Van Belle <jvbelle@commerce.uct.ac.za> 25    

Using the Insert Object Method 
If the object already exists as a separate file on disk, or if you 
wish to create a new object using another application for inser-
tion (and linking) in the current application, you can use the 
Object option from the Insert menu.  

This option will open a window to ask you for the type of object 
(application) and you will also need to specify whether you 
want an embedded object (which remains the static) or a 
linked object (dynamic i.e. reflecting updates). 
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Exploring and Managing Info on Your Computer 
You can find out what information is stored on your computer (and the data drives reserved 
for you by the network) by using “My Computer” and “Network Neighbourhood”. This opens 
window allowing you to explore your drives, folders and documents. Because the application 
used to explore your folders is called explorer and previous versions of Windows used to 
have an application with the name “Windows Explorer”, we shall refer to it as explorer in this 
section. 

Using “My Computer” to See What’s On Your Computer 
Everything on your com-
puter is accessible from 
the “My Computer” icon on 
your Desktop.  

 

Double-click this icon to 
get an overview of your 
computer system. 

If you double-click on of 
your disk-drive icons, a 
window will display the in-
formation that is stored on 
your drive.  

Some important 
document folders 
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Using The Folders View to Manage Files and Folders  
The most powerful way of managing files and folders on your system is by means of the 
Folders view. Click the Folders button on your explorer window to enable the folders view. 
Below is a typical explorer window. 

 

Opening a folder 
To display the contents of a folder in the right window, click on its folder icon in the left (or 
right) window. 

To see the detailed structure of a folder/disk drive (i.e. its sub-folders), click the  +  symbol 
next to the folder/drive icon in the left window.  To hide the detailed structure again, click the  
–  symbol which will now have appeared. 

Selecting files or folders 
To select a single file, click it in the contents window.  

To select additional individual files, hold down the <Ctrl>-key while clicking.  

To select a continuous series of files: click the first (top) file, point to the last (bottom) file and 
hold down the <Shift>-key while clicking it.  

Right window: shows 
the contents of the 
open folder on the left 

Left window: shows 
the folder structure 
of your disk drives 

Click on a folder 
icon to open i.e. 
see its contents 

Click + to 
see detailed 
structure 

Select any files 
for copying, mo-
ving or deleting 

Details about 
selected files 

Click to enable 
Folders view 
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All the selected files you have selected will be highlighted. The number and total size of the 
selected files appears in the window bottom. You can also select entire folders in the same 
way. 

Moving files 
To move files to a different folder in the same directory, just drag and drop them in the folder 
(in the right or left window).  

To move files to another drive, use the Cut and Paste options of the Edit menu. 

You can also move entire folders in the same way. 

Copying files 
To copy files to a different folder in the same directory, drag them to the selected folder but 
hold down the <Ctrl>-key before dropping them. A plus  +  sign should appear underneath 
the cursor to indicate that a copy will be made. If the  +  sign does not appear, the files will 
be moved instead of copied. 

To copy files to another disk drive, just drag and drop them on the drive icon in the left win-
dow. You may drop them in any folder that is visible.  

Dropping files on the printer icon will automatically print them out! 

You can also copy entire folders in this way. 

Deleting files 
Select the files (or folders) you wish to delete and press the <Del>-key or drag them to the 
recycle bin if it is visible. 

To create a new folder 
Click the folder or drive where you want to create the new folder. Select the New option un-
der the File menu to create a new folder. 

To rename a folder or file 
First select the folder or file you wish to rename. Select the Rename option under the File 
menu to rename the folder or file. You can also first select (click) the name in the right win-
dow, then click the name again which will allow you to edit its name. (This action is not the 
same as double-clicking!) 

Right-click menu 
You can also right-click a folder or file to perform most of the above tasks such as copying 
(“send to”), renaming, etc. much more quickly.   

For example, to copy a selected file or folder to your diskette in the A: drive, you could drag 
and drop it to the A: drive icon (in the right window), but the icon may not be visible. A 
quicker alternative is to right-click the file/folder, select the Send to option, and select A: from 
the available destinations.  
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Opening several Explorer windows 
If you want to do a lot of file or folder shuffling between two (or more) different folders and/or 
drives, you may wish to open several Explorer windows to make drag and drop easier. 

Changing the way files are presented in Windows Explorer 

The icons representing folders and files in Windows Explorer 
are very user-friendly but tend to take up a lot of screen space. 
If you want to see the list of folders and files in a more con-
densed textual format, choose the Details (or List) option on 
the View menu or click the Views button on the toolbar. 

 

 

 

 

More information about individual 
files 
It is often useful to find out more 
about a specific file. Right-click a file 
and select Properties from the menu 
to find out details about its creation 
and modification date, author, file 
size and system attributes.  
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Creating a File Shortcut and Quick Copying 
The right-click menu is also very convenient to quickly copy (“send”) a file to a diskette (A: 
drive) or to create a link to the file, called a shortcut, on the desktop. 

Searching for a File 
Click the Search Button on the toolbar and supply the nec-
essary search criteria.  

Note that if you use the “A word or phrase in the file:” op-
tion, the search may take quite a while. 
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Exercises 
Here are some exercises for you to try. 

1. Load the Paint accessory. Draw a line. 

2. Save your drawing as “LINE” in your My documents folder on the C: drive. 

3. Save it a second time with the new name “MODERN” on your desktop. 

4. Open the C: drive with Explorer. How many folders are there?  

5. How many files are there in the Windows folder (excluding sub-folders)?  

6. What is the size of the newest File in the Windows folder? 

7. What is the total size (in Kilobytes) of all files in the Windows folder?  

8. Create a folder in My Documents (C:) called PRIVATE 

9. Copy your LINE file into the PRIVATE folder. 

10. Load the help and find “Creating a shortcut in a folder”. How many steps does the 
help suggest to create a shortcut in a folder? 

11. Load the Calculator (Accessories). How much is 773322 divided by 789? 

12. One way of changing between running applications that are maximised is by clicking 
on their open window. What are the two other ways? 

13. Load the help and index. Find “screen saver”. How many steps does the help sug-
gest to set up and customise a screen saver? 

14. Create folder within the PRIVATE folder called “PCTEST”. 

15. Load NotePad and write your student name, student number and home address. 

16. Save the note as MyName in the PCTEST folder. 

17. What is creation date of the oldest file in the Program Files folder on C: ? 
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